MATH AND SCIENCE @ WORK

AP* CHEMISTRY Educator Edition

i3 TeExAs
INSTRUMENTS

A BREATH OF FRESH AIR
TI-Nspire™ Lab Activity

The Math and Science @ Work problem, Oxygen Generator System, may
be used to reinforce and assess the material learned from this lab.

Instructional Objectives

Students will
e construct an electrolytic cell;
e determine the number of moles and mass of oxygen produced;
e determine the number of electrons transferred; and
e compare their experimental electrolytic cell to the Oxygen Generator
System used on the International Space Station.

Teacher Preparation

o Distribute the TI-Nspire file, Breath_Fresh_Air.tns, to the students’
handhelds.
¢ Have the following available for each lab station:
0 9-12 V DC power sources (less than 0.5 amperage)
o Electrolysis apparatus (students can use a Hofman tube or two
graduated gas tubes and electrodes in a beaker)
Vernier EasyLink Cables
Vernier Current Probes
Three wires with alligator clips
Potassium hydroxide (KOH) with a balance
Scoop

O O0OO0O0O0o

Safety Considerations

e Students should wear safety goggles and aprons.

e Students should avoid physical contact with potassium hydroxide.
Potassium hydroxide is a toxic, corrosive material that causes
severe burns to skin, eyes, respiratory tract, and gastrointestinal
tract. Refer to MSDS sheet when using this material with your
students.

¢ Students should avoid contact with any bare metal in the electrical
circuit.

Grade Level
10-12

Key Topic
Electrolysis

Teacher Prep Time
20 minutes

Lab Time
90 minutes

Materials/Equipment

- TI-Nspire Handhelds

- TI-Nspire File:
Breath_Fresh_Air.tns

- Electrolysis apparatuses

- DC power sources

- Vernier EasyLink™

Cables

- Vernier Current Probes

- Wires with alligator clips

- Potassium hydroxide

- Scoop

AP Course Topics
Reactions:

- Reaction Types

- Stoichiometry

NSES

Science Standards

- Physical Science

- Science and Technology

- History and Nature of
Science

*AP is a trademark owned by the
College Board, which was not
involved in the production of, and
does not endorse, this product.
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Class Time Required

This lab requires 90 minutes. If the class period is 60 minutes or less, have students read through the
background material, answer the pre-lab questions, and set up for the lab on the first day. On the
second day, students may complete the lab and the lab analysis questions.

e [ntroduction: 10 minutes
e Student Work Time: 70 minutes
e Post Discussion: 10 minutes

AP Course Topics

Reactions
e Reaction types
o0 Oxidation-Reduction reactions

- Oxidation number

— The role of the electron in oxidation-reduction

- Electrochemistry: electrolytic and galvanic cell; Faraday’s laws; Nernst equation;
prediction of direction of redox reactions

e Stoichiometry

0 lonic and molecular species present in chemical systems: net ionic equations

0 Balancing of equations including those for redox reactions

0 Mass and volume relations with emphasis on the mole concept, including empirical
formulas and limiting reactants

NSES Science Standards

Physical Science
e Chemical Reactions

Science and Technology
o Abilities of Technological Design

History and Nature of Science
e Science as a Human Endeavor

Background

This lab activity is part of a series of activities that applies Math and Science @ Work in NASA’s
scientific labs.

The International Space Station (ISS) is a research laboratory being assembled in low Earth orbit.
Construction of the ISS began in 1998 and is scheduled for completion in 2011. Crews aboard the ISS
conduct experiments in biology, chemistry, physics, medicine and physiology, as well as in
astronomical and meteorological observations. The microgravity environment of space makes the ISS a
unique laboratory for the testing of spacecraft systems that will be required for future exploration
missions beyond low Earth orbit.

The ISS travels in orbit around the Earth at an average speed of 27,743.8 km/h (17,239.2 mph),
completing 15.7 orbits per day. The ISS is operated jointly among five participating space agencies: the
United States’ National Aeronautics and Space Administration (NASA), the European Space Agency
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(ESA), the Russian Federal Space Agency (RKA), the Japan Aerospace Exploration Agency (JAXA),
and the Canadian Space Agency (CSA).

An international crew, typically consisting of six members, resides on the ISS for approximately six
months at a time. Since the first crew aboard the ISS in 1998, humans have maintained a permanent
presence in space. In addition to the crew, personnel on the ground (located in Mission Control
Centers) direct the operations of the ISS.

The ISS requires a constant supply of oxygen to keep the astronauts safe and in top condition.
Because oxygen is a consumable on the ISS, there must be a continuous source of new oxygen. On
Earth, new oxygen is produced from plants through the process of photosynthesis. On the ISS, there is
not enough space to carry the amount of plant material that would be required to produce the oxygen
needed. Instead, oxygen is supplied by a variety of sources.

Figure 1: The ISS orbiting the Earth as observed by Space Shuttle
Discovery on March 26, 2009

The primary sources of oxygen are the Russian-built Elektron Oxygen Generator unit and NASA'’s
Oxygen Generator System (OGS). Both convert water collected from a variety of sources within the ISS
(e.g. urine, wastewater, and condensation) into hydrogen (H2) and oxygen (O2) through the process of
electrolysis. Potassium hydroxide (KOH) is used as an electrolyte, creating a solution that is 30% KOH.
When a current is placed on the solution, oxygen and hydrogen are produced. The oxygen is released
into the ISS atmosphere and the hydrogen is fed into the Sabatier Reactor, another piece of equipment
which combines H2 with CO2 to create water and methane. The water then feeds back into the OGS,
venting the methane into space and completing a regenerative life support cycle on the ISS.
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Figure 2: A mock-up of the OGS Figure 3: Astronaut Daniel W. Bursch

located in the Tranquility Module working on the Elektron Oxygen Generator
on the ISS in the Zvezda Service Module on the ISS

Lab Procedure

With your lab partner, gather the required materials/equipment. On your TI-Nspire handheld, open the
file, Breath_Fresh_Air. Read the provided information and answer the Pre-Lab questions that follow (TI-
Nspire pages 1.1-1.9). You will then be ready to start the lab activity. Go to TI-Nspire page 2.1 and
follow the provided instructions. Following the Lab Activity, proceed to the Lab Analysis on TI-Nspire
pages 2.8-2.15.

Solution Key

Throughout this activity, students are given most of the information and questions in the TI-Nspire file,
Breath_Fresh_Air. Students are also provided with the questions on the student handout. Some
screenshots have been provided throughout the solution key to show what students will be reading on
their handhelds. A TI-Nspire file with the solutions, Breath_Fresh_Air_Solutions, is also provided for the
teacher to discuss solutions with students using TI-Nspire software and a projector.

Mission (TI-Nspire pages 1.1 — 1.3)

The International Space Station (ISS) must continually regenerate oxygen. NASA’s Oxygen Generator
System (OGS) is one source of oxygen on the ISS. Figure 4 depicts an electrolysis process similar to
the one used by the OGS to produce oxygen. The OGS was designed to be capable of providing
enough oxygen for at least six crew members on the ISS. On average, a crew of six will consume 5.44
kg of oxygen in a 24-hour period.
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You are one of the NASA design engineers for the OGS system and you need to determine the most
efficient design of the system in order to provide the oxygen needed for the crew to live and work.

Vents to Cabin Sent to Sabatier Reactor

Collected O2(9) [, Collected Hz(g)
H/
5 2
r :; d \
H20 and KOH 50. AMP
\_ ) Current

Figure 4: Diagram depiction of the electrolysis process used in
the OGS system in one of multiple electrolytic cells
Pre-Lab Questions (TI-Nspire pages 1.4-1.9)
1.4 How many moles of oxygen gas are present in 5.44 kg of oxygen?

170. moles O,

Students should show work on the calculator section of TI-Nspire page 1.4 as shown.

Breath_Fres..-11 <=

] <

How many moles of
oxygen gas are present
inS.44 kg of oxygen?
0.170 mol 02
0.340 mol 02
@ | 170. mol 02

) | 340. mol 02

©Calculate grams
of 02

1000 5440,

1

5.44

©Calculate moles

5440-—1
32

170.

4/99
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1.5 How many moles of water are needed to produce 5.44 kg of oxygen gas?

340. moles H,0O

Bl’Bath_Fregm_“l — {] B

How many moles of 170 mol O2
water are needed to convert to moles
produce 5.44 kg of of H20
oxygen gas?
2 240,
170.-—
1
) | 0.170 mol H:0
0.340 mol H:O
)| 170. mol H20
®) | 340. mol H:0 2/90

1.6 What is the balanced reaction equation for the electrolysis of water?
2H,0 - 2H, +0,
1.7 How many electrons are exchanged in the electrolysis of two water molecules?

4 electrons

1.8 How many moles of electrons are exchanged if 5.44 kg of oxygen is produced in 24 hours?

680. mol e~
Breath_Fres..-11 == ‘[]
How many moles of ©170 mol 02
electrons are exchanged reacts with 4 mol
if 5.44 kg of oxygen is e—
produced in 24 hours?
170._& 680,
1
(®) [680. mole-
)| 340. mol e
)| 170. mol e~
)| 5.44 mole” >/59
. . 96,500 C
1.9 Given that a Faraday is ————, how many coulombs (C) are needed to produce
1mole
200.0 mol e ?
1.930x10" C
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Lab Activity (TI-Nspire pages 2.1-2.7)

e

Students are given lab instructions in the TI-Nspire file. Screenshots are provided below ordered from
left to right. Note that even though one calculator is collecting the data, all students’ handhelds may be
used to complete the activities using the data found from the collection.

graduated
gas tubes

electrodes

3% KOH solution

* *Breath_Fre.. -11 =

DC source
(9% aned bess than 0.500 amps)

current probe
TI-Mspire
handheld

EasyLink Cable

Lab Instructions

1. Create 100 mL of 3% KOH solution by
dissolving 3 g KOH in 97 g water.

2. Construct the electrolysis apparatus (see
diagram on page 2.2),

3. Fill the electrolysis apparatus with the
KOH solution.

www.nasa.gov
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' b *Breath_Fres.-11 = ol < |

4, For connection 1, connect the current
probe in the circuit between the DC source
and the electrolysis apparatus.

5. Plug the current probe into the EasyLink
cable then into the TI-Nspire.

&. On the DataQuest Application on page 2.5
set the collection mode to time based for 2
second samples for 240 seconds.

' > Breath_Fres.-11 <
7. Press the start button (»)and attach the
pOWer source,

Note: When the gas tube is half full
disconnect the power and stop sampling.

Breath_Fres...-11 =

e Current
0.0006 A
¥ Stats:

Current (&)

Tirne (5) 12000

| *Breath_Fres..-11 == Lol <]

A
1. On page 2.5, select the region of the graph
where current was applied.

» Place curser at the last point where current
was applied.

» Click and hold until double arrow appears.
» Swipe finger to the left most point where
currentwas applied.

» Click to set the left bound.

1 »  *Breath_Fres..-11 ==

2. Strike data outside the region selected

{press ctrl and menu, then select Strike
Data » Qutside Selected Region).

3. Analyze the data and calculate the
statistics {press ctrl and menu, then select
Analyze > Statistics). Record the mean
amperage below, Press enter fo store it,

*Breath_Fre.. -11 =

e Current
03722 A
¥ Stats:
3. 203
min: 0.007

Current (&)

o i
amp:=0 0 Tire (z) {20.0
o

24|25 |28 425 |25 | 27 RN N TR N R
(7] rat 2. Strike data outside the region selected
puni Stats2: on runi.Current S (press etrl and menu, then select Strike

17 ::;%Eogdzzggfaaaa Data = Qutside Selected Region).

115 J
eCurrent | | Samples: 202 3. Analyze the data and calculate the
0.37224 | min: 0.303705000 statistics (press ctrl and menu, then select

Stats1: 3 = L.
;a i ,3200 LLEE5 e bl ~ Analyze > Statistics). Record the mean

min: 0.304 amperage below. Press enter to store it,
RN B i

e ] Timme (2) 120.0 amp:=0.414

www.nasa.gov
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Lab Questions (TI-Nspire pages 2.8-2.9)
2.8 Which tube contains oxygen?
The tube with lesser volume
2.9 What term describes the process that occurs when oxygen is produced?
Oxidation

Lab Analysis (TI-Nspire pages 2.10-2.16)

Screenshots below show sample data for the experiment. Students’ data will vary and this will
cause a variance in the answers to the questions asked.

{ *  *Breath_Fres..-11 <= C_IF!'I

{ *  *Breath_Fres..-11 <= C_IF!'I

Al

Lab Analysis Data - Enter volume, temperature and
Using the data gathered, you will be pressure.
calculating the moles of oxygen produced Volume of Q2 (ML) vol_02:=3 05
and the number of electrons that passed Temperature of O: (°C) temp_02:=21.
through the system.

Pressure of Q2 (atm) press_o2 =0 897

Time that current was applied (s)

time_amp » 9.5

Averade current anolied (ambs) i

2.12 Calculate the moles of oxygen produced.

Students will first need to convert volume to liters and temperature to Kelvin.

1.13x10"* mol O,

{ ' *Breath_Fres..-11 <= {]m { ' *Breath_Fres..-11 <= {]m

A 3 A
©Convert volume to liters s ©Convert temperature to Kelvin :
1000 ©Calculate the number of moles of 02
©Convert temperature to Kelvin i 0.00305-0.897 0.000113
6f99| 6f99|
W A
Calculate the moles of oxygen produced. Calculate the moles of oxygen produced.
vol_o2 » 2.05; temp_o2 » 21.; H vol_o2 » 2.05; temp_o2 » 21.; H
press 02 » 0 897 v press 02 » 0 897 v

www.nasa.gov
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e

2.13 How many moles of electrons were needed to produce the number of moles of oxygen found in
question 2.127?

Using the students answer from the last problem, they should have four times as many
electrons as oxygen molecules.

452 %10 * mole”

1 mol O2 needs 4 mol electrons

000452
1.13E-4% 0.0

2/99 |

"~

How many moles of electrons were needed
to produce the number of moles of oxygen !
found in question 2,127 =

2.14 How many moles of electrons passed through the current probe?

4.27 x10™* mol e~

{ -' *Breath_Fres..-11 <= {:-]

©Calculate moles of electrons using a A&
faraday
p 0.000427
anmp - ane_anigp”
z e 96500
]
39|
~
How many moles of electrons passed
through the current probe? !
time_amp » 99.5; amp » 0 414 =

2.15 Compare the number of electrons that passed through the current probe and the number of
electrons needed to produce oxygen. Give an explanation for the difference.

Student answers will vary for this question. DC power sources have a variability based on their
quality. Because of the variability, the amperage is taken as an average of the amperage
therefore; the number of moles of electrons measured by current may turn out slightly different
than the moles of electrons that were measured by the volume of oxygen generated.
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2.16 If the OGS runs at 50. amps, how many electrolytic cells are needed to produce the oxygen
required by six astronauts if each astronaut needs 0.91 kg of oxygen in a 24-hour period?

50.C 3,600s 24 hr 1mole” 1molO, » 32.0¢g 358 g O
. = 2

ls 1hr .1day.96,500C.4moIe‘ 1 mol O,
0.91 kg
1 astronaut

358 g0, — 9 _0.358 kg O,

6 astronauts - =5.46 kg

1,000 g
1 cell
5.46 kg -———— =15 cells
0.358 kg
¢ ' *Breath_Fres..-11 <= ‘:-] { ' *Breath_Fres..-11 <= ‘:-l
©Convert 50 amps over 24 hours to moles F ©Convert grams O to kg O: generated by a
O one cell
50 3600 24 1 1 32 358.135 358 —1 0.358
1 1 1 96500 4 1 1000
©Calculate kg of Oz needed by 6 astronauts ©Calculate the number of cells to produce
5 04kgof O.
0.91 5.46
& T 1 152514
0.358
— .l .l
/99 599 |

Contributors

This problem was developed by the Human Research Program Education and Outreach (HRPEO)
team with the help of NASA subject matter experts and high school AP Chemistry instructors.

NASA Experts

Tess Caswell — Environmental and Thermal Operating Systems (ETHOS) Operator, International
Space Station Mission Control Center, NASA Johnson Space Center

Sarah Hargrove — Environmental and Thermal Operating Systems (ETHOS) Operator,
International Space Station Mission Control Center, NASA Johnson Space Center
AP Chemistry Instructor

Todd Morstein — Texas Instruments T° (Teachers Teaching with Technology™) National
Instructor, Glacier High School, Kalispell School District, MT
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